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Overview of Premiere Elements workspace 
When you start Premiere Elements, the Welcome screen (Figure 1) provides two options: 


• The Organize button opens Elements Organizer. In the Organizer you can organize and manage your 
videos, do quick editing, create projects automatically by using these videos, and share the videos. (The 
same Organizer is used with both Photoshop Elements and Premiere Elements.) 


• The Video Editor button opens the Premiere Elements Editor, which provides a rich set of features for 
editing videos. When you click this button, two options are presented: the Existing Project button presents a 
list of projects that you recently edited; or, the New Project button opens the Premiere Elements Editor with 
a blank project. 


 
Figure 1 Premiere Elements Welcome screen 


The Organizer workspace 
Elements Organizer (Figure 2) works with both Photoshop Elements and Premiere Elements. The Organizer is 
available as an option on the Welcome screen. 


 


 


 
Figure 2 Elements Organizer 
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Using panes and menus in the Organizer 
You can filter your files and perform a number of quick tasks in the Organizer without opening either Premiere 
Elements or Photoshop Elements. 


The Organizer has the following four filtering modes above the workspace: 
• Media: The Media workspace displays all your videos and images (Figure 2). You can select images and 


videos in the Media view and use the toolbar at the bottom to name people, add locations, and tag photos by 
event. 


• People: Displays all the people you have named and tagged. 
• Places: Display photographs and videos by location (Figure 3). 
• Events: View the events you have created. 


 


 
Figure 3 Places tab 


  


The Organizer has the following two quick task buttons in the lower right of the workspace: 
• Instant Fix: Perform quick edits on photos, such as fixing redeye or automatically adjusting levels. For 


example, you can quickly apply the Auto Color or Auto Levels command to photos (Figure 2). 
• Tags/Info: Assign media keywords and specific tags so you can find them later. You can also give caption 


and notes for individual images (Figure 4). 
 


 
Figure 4 Tags and Information panels 
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The Organizer has the following four filtering tabs above the workspace: 


• Create: In the Create workspace, you can quickly create photo collages, photo books, DVDs, and other 
projects (Figure 5).  


• Share: In the Share workspace, you can generate versions of videos and images to share. For example, you 
can share images and videos via social sites or to another user’s computer or mobile device (Figure 5). 


  


 
Figure 5 Create and Share tabs 


Premiere Elements Edit workspace 
The Adobe Premiere Elements workspace presents a simplified interface for enthusiasts. It organizes features into 
the Quick view and Expert view based on their complexity (Figure 6).  


The Quick view aggregates basic features that enthusiasts commonly use to quickly edit video footage and share 
with others. It optimizes common tasks that you perform with clips, such as editing clips, creating menus for DVDs 
and Blu-ray discs, and sharing movies. 


The Expert view includes advanced features and tools, such as Audio Mixer, Time Stretch, that professionals use to 
perform intricate video editing tasks. 


To switch between views, click the tabs at the top of the workspace. 
  


 
 
 


Figure 6 Premiere Elements view modes 
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Using menus and panels in the Editor 
The Premiere Elements workspace is optimized for the major phases of a project: importing and organizing footage, 
editing and enhancing a movie project, and sharing a finished project. (Figure 7). 


 


 
 
 


Figure 7 Premiere Elements Editor workspace 
 


Add Media, with Project Assets added in Expert view: Use these panels to add and organizing footage (video, stills, 
and audio). 


Menu bar: Contains menus for performing tasks, organized by topic. For example, the Timeline menu contains 
commands for navigating through the Timeline. 


Monitor panel: Displays your project at its current playback position. 


Tasks panels: Offers options for adjustments, refining applied effects  and sharing projects. 


Action Bar: Contains options that provide easy access to common features you use for editing tasks. Use the options 
to add titles, transitions, special effects, graphics, music, and markers to your clips. 


Timeline: Available in two views, Quick and Expert. Enables you to add, edit, and view a project as lines or clips. 
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Importing and organizing media  
In the Project workspace you can import, manage, and organize your projects, clips, and other media using the Add 
Media and Project Assets panel (Figure 8). 


• In the Add Media panel lets you add media files from various sources to the Quick view timeline or so you 
can rearrange and edit them. 


• In Expert view, the Project Assets panel displays all video clips, audio clips, and still images that have been 
added to the project. You can filter this workspace by album, tag, rating, or media type.  
  


 
Figure 8 Add Media and Project Assets panels 
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Editing and enhancing your project 


The Monitor panel 


You can preview all or part of a movie at any time in the Monitor panel (Figure 9). To preview a movie, Adobe 
Premiere Elements must first prepare the clips on all the tracks for viewing, applying effects, motion, opacity, and 
volume settings. Video quality and frame rate are dynamically adjusted to let you preview the movie in real time. 
Movies that use only cuts between clips generally preview at normal quality and frame rate. Complex movies (with 
effects and layered video and audio) may require rendering before you can preview them. 
  


 
 


Figure 9 The Preview window 


You can view safe zone margins (guides) in the Monitor panel to determine if any text or objects in your project fall 
outside the safe zone (Figure 10). When text or objects fall outside the safe zone, they may be clipped when played 
back on certain screens. Safe zone margins are for your reference and are not included in previews or export. 
  


 
Figure 10 Safe zones in the Monitor panel 
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To see the greatest detail in a clip or movie, preview it in full-screen mode (Figure 11). This mode fills the 
computer screen with video, suggesting how clips and movies appear on TV screens. Full-screen previews also let 
you easily share your work with others in the room. 


 
Figure 11 In full-screen preview, move the pointer across the screen to display the player controls. 


Timelines 


The Timelines let you assemble your media into the desired order and edit clips. You use the Monitor panel to 
preview the clips you’ve arranged in either the Timelines. The Timeline is available in Quick view and in Expert 
view (Figure 12). 
  


 
Figure 12 Quick view Timeline (top) and Expert view Timeline (bottom) 


  


The Quick view timeline contains the following tracks:Video, Titles, Sound, and Narration. The Quick view 
timeline displays each clip as a series of frames that span the entire clip length. You can trim unwanted portions 
within individual frames and rearrange them. You can also swap the position of a clip with another to make a 
coherent movie sequence. 


For more advanced editing, use the Expert view timeline. The Expert view timeline graphically represents your 
movie project as video and audio clips arranged in vertically stacked tracks. When you capture video from a digital 


Exit 
button 
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video device, the clips appear sequentially as they occur. The Expert view timeline uses a time ruler to display the 
components of your movie and their relationship to each other over time. You can trim and add scenes, indicate 
important frames with markers, add transitions, and control how clips are blended or superimposed. Compared to the 
Quick view, the Expert view timeline has more tracks. 


Adjustments and Applied Effects 


Use the Adjustments and Applied Effects panels to improve the appearance of your clips, and add effects to your 
clips:  


• The Adjustments  panel provides you an easy way to adjust Color, Lighting, and Temperature and Tint. Use 
the SmartFix option to apply automatic adjustments to your footage. Expert view provides advanced 
adjustment options for Color (RGB) and Gamma Correction (Figure 13). 


• The Applied Effects panel enables you to refine any effects you have applied to your video. Here, you can 
do everything from adjusting color levels to giving your project the appearance of an old film (Figure 13). 
  


 
Figure 13 Adjustments and Applied Effects panels 


 


The Action Bar 


At the bottom of the Premiere Elements workspace (Figure 14) is the Action bar that contains options to provide 
easy access to common features you use for editing tasks. Use the options to add titles, transitions, special effects, 
graphics, music, and markers to your clips:   


 


 
Figure 14 The Action Bar 
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• The Instant Movie dialog box enables you to automatically create a movie based on a theme from the clips 
currently in the organizer (Figure 15).  
  


 
Figure 15 Instant Movie dialog box  


  


• The Tools panel provides a wide selection of video editing tools such as Adjustments, Freeze Frame, Movie 
Menu, Narration, Pan & Zoom, and more (Figure 16). 
 


 
Figure 16 Tools panel 
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• The Transitions panel enables you to add and edit a range of transitions, such as slides, blends, and 
dissolves (Figure 17). 
  


 
Figure 17 Transitions panel 


  


• The Titles & Text panel enables you to add titles and credits to your project, choosing from a range of 
preformatted templates (Figure 18). 
  


 
Figure 18 Titles & Text panel 
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• The Effects panel enables you to add effects to a clip to enhance your movie by dragging and dropping 
(Figure 19). 
  


 
Figure 19 Effects panel 


 


• The Music panel enables you to add music to the soundtrack (Figure 20). 
  


 
Figure 20 Music panel 
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• The Graphics panel enables you to add graphics and clip art to your video (Figure 21). 
  


 
Figure 21 Graphics panel 


 


Sharing your finished project 


You can export and share movies, stills, and audio in a variety of file types to the web, mobile devices, videotape, 
Video CDs, and Super Video CDs. You can also copy and save projects for editing and storage. The Publish+Share 
panel contains everything you need to share your finished project (Figure 22). You can share your project on the 
web or on a DVD, a mobile device, your computer, and more. 


  


 
Figure 22 Publish+Share panel 
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How to add titles 
You can design custom titles and images with Adobe Premiere Elements. Titles are a valuable addition to a movie 
and can serve many purposes, from naming the people and places in your movie to providing movie-style credits at 
the beginning and end. You can create titles by using any font installed on your computer and create other graphic 
objects by using the title’s shape-creation tools. You can create images from any graphic or photograph on your 
computer and use them to further customize and enhance your movies. 


You can use the text and shape tools to create your titles from scratch, or you can use the included templates, preset 
text styles, animations and images to quickly create an attractive title. 


The title view is arranged over a suite of several option tabs including Text, Style, Animation, and Shapes (Figure 
1). Adobe Premiere Elements optimizes the workspace for titles whenever you open or create a new title. 


By default, when you create a new title, the title appears superimposed over the video clip at the position of the 
current-time indicator. However, you can choose to place it in an empty area of the Expert view timeline with no 
underlying video. Later, you can drag the title from the empty area onto a clip. 


 


 


 
 
 


Figure 1 Title tools and options in the Monitor panel and the Tasks panel        
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About titles 
You can open the title view and start a new title by using a menu command. Titles are embedded in the project file 
rather than being saved as independent files. Titles open in the Monitor panel. Reopen a title when you want to 
change it or when you want to duplicate it and base a new version on it. If you want to use a title in another project, 
you must open its project and export the title by using the File > Export > Title command. Then you can import it 
into another project as you would any other source file. 


To create a new title: 


1. Click the Expert tab at the top of the workspace. 


2. Choose File > New > Title. 


 Note: You can also click the Titles & Text button in the 
Action Bar and drag a Title onto the Timeline or 
Monitor panel. 


 A title appears centered on the currently chosen clip 
(Figure 2). 


3. Begin typing to replace the temporary text in your title. 


4. Make one or more of the following changes using the 
Drawing tools in the Adjust panel (Figure 3): 


• Click the Selection tool and drag the text to change 
the location of the title. 


• Highlight the text or position the insertion point to 
edit the text. 


• With the text selected, click the Color Properties 
tool to open the Color Properties dialog box and 
change the color of the text. 


5. Use the other Text options to change one or more of the 
following attributes of the text: 


• Font or font style 


• Size 


• Alignment 


 Note: You can also select from a set of preformatted 
styles in the Styles tab (Figure 4). 


 When you are finished, you can resume other editing 
tasks or repeat the preceding steps to create more titles. 


 The new title appears on a new video layer in the 
Timeline (Figure 1). The new title has a duration of five 
seconds. To increase or decrease the amount of time that 
text displays, drag its borders in the Timeline. 


 
Figure 2 Adding a title 


 


 
 
  


Figure 3 Text options in the Adjust panel 


 


 
Figure 4 Text Styles  
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To edit a title: 


1. Click the Expert tab at the top of the workspace. 


2. Double-click the title in the Timeline (Figure 5) or 
directly in the Monitor panel. 


 The text opens for editing in the Monitor (Figure 6) and 
the Adjustments panel expands to show text options. 


3. Make one or more of the following changes by using the 
buttons in the right margin of the Monitor: 


• Click the Selection tool and drag the text to change 
the location of the title. 


• Click the Type tool and highlight the text or 
position the insertion point to edit the text. 


• With the text selected, click the Color Properties 
tool to open the Color Properties dialog box and 
change the color of the text. 


4. Use the other Text options to change one or more of the 
following attributes of the text: 


• Font or font style 


• Size 


• Alignment 


 Note: You can also select from a set of preformatted 
styles in the Styles tab (Figure 4). 


5. Click on another clip in the Timeline to exit text editing 
mode. 


 


 
Figure 5 Title in the Timeline 
 


 
Figure 6 Text open for editing in the Monitor 
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About templates 
The title templates included with Adobe Premiere Elements provide several themes and preset layouts that make it 
quick and easy to design a title. Some templates include graphic images that may be pertinent to your movie’s 
subject matter, such as new baby or vacation themes. Others include placeholder text you can replace to create 
credits for your movie. Some templates are completely opaque; others have transparent backgrounds, depicted by 
dark gray and light gray squares, so you can see your video beneath the title. 


You can easily change every text or graphic object in the template by selecting an object and either deleting it or 
overwriting it. You can also add objects to the title. Once you modify the template, your unique version of the title is 
saved with your project without changing the template on which it is based. 


Note: When you apply a new template, the template content replaces any content currently in the title view. If you 
share templates between computers, make sure both computers have all the fonts, textures, and images used in the 
template. 


To create a new title from a template: 


1. In the Quick or Expert view, click the Titles & Text 
button in the Action Bar to preview templates. 


2. Browse to a template by scrolling through the available 
templates (Figure 7). You can also filter templates by 
category from the category menu. 


3. To apply a template, drag the template into the Monitor 
panel. 


 The template is available for editing in the Monitor 
panel. 


 Note: You can also double-click a template to open it in 
the Preview window.  


4. Modify the title or templates as desired (Figure 8). 


 Note: The template is added to a new layer and is the 
top-most layer in the Timeline. After adding a template, 
you may need to adjust other order or position of other 
titles and graphics that appear on other layers.  


 


 


 
Figure 7 Selecting a title template 


 


 
Figure 8 Editing the selected template 
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About styles 
You can create a new style, or adapt an existing style using Text option, and save your customized style to the Style 
tab of the Adjustments panel (Figure 9). You can then apply that style to any text or shape element in your title. 
You can save any number of styles. Thumbnails of the styles appear in the Style view of the Adjustments panel so 
you can quickly apply your custom styles across projects 
  


 
Figure 9 Adjustment panel with Text and Style options tabs  


 


To create a style and display its swatch or name: 


1. Click the Expert tab at the top of the workspace. 


2. Double-click the title in the Timeline or directly in the 
Monitor panel. 


 The text opens for editing in the Monitor and the 
Adjustments panel expands to show text options. 


3. Click the Styles tab and scroll to browse the styles 
(Figure 9). 


4. Right-click on a selected style and choose Duplicate 
Style.  


 The style is duplicated and added to the bottom of the 
Styles list. 


5. Click the duplicated style to apply it. 


6. Use the Text options in the Adjustments panel to 
customize the font, size, color, alignment and other 
options (Figure 10). 


7. When you are happy with the look and feel of the style, 
right-click the newly-created style and choose Save 
Style.  


       The Save Style dialog box opens (Figure 11).  


 
Figure 10 Right-click Style 


 


 
Figure 11 Save Style dialog box 
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8. Type a name for the style and click OK. 


 The new style swatch displays the new style in the 
Styles tab (Figure 12). 


Note: Styles are always represented by a font, even if the 
object on which you based the style is a shape object. 


 
Figure 12 Save Style  


 


To apply a style to an object: 


1. Select the object to which you want to apply the style. 


2. In the Styles tab of Adjustments panel, click the style 
swatch you want to apply (Figure 13). 


 You may need to adjust the font size or reposition the 
text so that it fits within the frame. 


Note: To prevent the font type in the style from being 
applied to the font in your title, Alt-click (Windows) or 
Option-click (Mac OS) the style swatch. 


 
 


Figure 13 Text Styles  


  


Applied Style 
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Formatting text 
Some object properties—such as fill color, shadow, and so on—are common to all objects you create in the title 
view, while other properties are unique to text objects. Text controls such as font, font style, and type alignment are 
in the Text tab in the Adjustments panel (Figure 14). 


  


 


 
 


 


Figure 14 Text Options in the Properties view 


 


To modify a font, font style, or type alignment: 


Select the text and do the following in the Text tab in the Adjustments panel: 


 To modify the font, choose a font from the Change Text Font menu. 


 To modify font size, alter the parameters for the Change Text Size. 


 To modify the font style, choose a font from the Change Font Style menu, or click one or more of the Bold, 
Italic, and Underline buttons. 


 To modify the text alignment, click one of the Left Align Text, Center Text, or Right Align Text buttons. 
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Adding shapes to titles 
You can also use the drawing tools in the Shapes tab of the Adjustments panel to create a variety of shapes, such as 
rectangles, ellipses, and lines (Figure 15). 


 


 


 
 


 


Figure 15 Shape tools in the Adjustments panel 


 


To create a shape: 


1. Select the title to which you want to add a shape. 


       The Adjustments panel opens. 


2. Click the Shapes tab to show the shape tool options 
(Figure 15). 


3. Select a shape tool. 


4. Do any of the following: 


 Drag to create the selected shape (Figure 16). 


 Shift-drag to constrain the shape’s aspect ratio (to 
create an oval that’s a precise circle or to create a 
rectangle that’s a precise square, for example). 


 Alt-drag (Windows) or Option-drag (Mac OS) to 
draw from the center of the shape. 


 Shift+Alt-drag (Windows) or Shift+Option-drag 
(Mac OS)  to constrain the aspect ratio and draw 
from the center. 


 Drag diagonally across the corner points to flip the 
shape diagonally as you draw. 


 Drag across, up, or down to flip the shape 
horizontally or vertically as you draw. 


5. Modify the new shape as needed. 


 
Figure 16 Shape created with the Ellipse tool  
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Adding colors and shadows 
You can specify the color properties of each object or group of objects you create in the title view. The Color 
Properties dialog box includes controls for setting the color, stroke, fill, and shadow of an object (Figure 17). To 
open the Color Properties dialog box, click the Color Properties button in the Monitor panel. 


Setting an object’s fill or stroke 


An object’s fill property defines the area within the contours of the object: the space inside a graphic object or 
within the outline of each character of a text object. You can also edit the outline, or stroke, of an object to which 
you’ve applied a style containing a stroke. 


Note: The Fill and Stroke boxes in the Color Properties dialog box are enabled only if you’ve applied a preset style 
from the title Properties Styles panel to the object. These styles contain fills and strokes you can edit. 


The Gradient menu provides options for applying a fill or stroke color. Color controls let you specify the color of a 
fill or stroke. Depending on the gradient type you select, additional color controls may appear. 
 


 
Figure 17 Color Properties dialog box 
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To set the fill, stroke, and gradient: 


1. Select an object in the title, and in the Text Styles 
section of the Properties view, select a style that 
includes a fill. 


2. In the Shapes tab of the Adjustments panel, click the 
Color Properties button (Figure 18). 


        The Color Properties dialog box opens. 


3. Modify any of the following properties: 


 Set the object’s fill color by using the Fill box. 


 Set the object’s stroke color by using the Stroke 
box. 


 In the Gradient menu, select the type of fill you 
want. If you select Linear Gradient, Radial 
Gradient, or 4 Color Gradient, color stop controls 
appear (Figure 19). 


 


 
 


Figure 18 Color Properties button 
 


 
Figure 19 Color stop controls 


Drop shadows 
You can add a drop shadow for any object you create in the Monitor panel. A drop shadow makes an object appear 
three-dimensional so it stands out from the background image. For example, adding a drop shadow to text can make 
the text more legible when superimposed over a complex background image. 


To create a drop shadow: 


1. Select an object and then click the Color Properties 
button. 


2. In the Color Properties dialog box, select the Drop 
Shadow option (Figure 20). 


3. Set any of the following: 


 Angle: Specifies the angle of the shadow in relation to 
the object. 


 Distance: Specifies the number of pixels the shadow is 
offset from the object. 


 Softness: Specifies how blurry or sharp the shadow 
appears. 


 
Figure 20 Color Properties dialog box  


Color Properties 
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Rolls and crawls 
Although static titles, graphics, and images may suffice for some projects, others require titles that move across the 
screen. (Titles that move vertically are called rolls. Titles that move horizontally are called crawls.) With Adobe 
Premiere Elements, you can easily create smooth, expert rolls and crawls. You can also make a title move along a 
custom path by keyframing locations for it at several points. 


To add roll or crawl options to selected text, select Text > Roll/Crawl Options in the menu bar (Figure 21).  


Note: The length of the title in the Timeline determines the speed of the roll or crawl. The more you increase the 
length of the title clip, the slower the movement will be. 
  


 
Figure 21 Text menu in the menu bar 


  


Roll and crawl options 
You can set the following options for rolls and crawls:  


Start Off Screen: Specifies that the roll or crawl begins out of view and moves into view. 


End Off Screen: Specifies that the roll or crawl continues until the objects are out of view. 


Preroll: Specifies the number of frames that play before the roll or crawl begins. 


Ease-In: Specifies the number of frames where the title rolls or crawls at a slowly increasing speed until it reaches 
the playback speed. 


Ease-Out: Specifies the number of frames where the title rolls or crawls at a slowly decreasing speed until the roll or 
crawl completes. 


Postroll: Specifies the number of frames that play after the roll or crawl completes. 


Crawl Left, Crawl Right: Specify the direction in which a crawl moves. 
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To create a rolling or crawling title: 


1. Do one of the following: 


 To create a rolling title, choose Text > New Text > 
Default Roll. 


 To create a crawling title, choose Text >  
New Text > Default Crawl. 


2. Create the text and graphic objects for the title 
(Figure 22). Use the scroll bar in the Monitor panel to 
view offscreen areas of the title.  


 When the title is added to the sequence, the hidden 
offscreen areas roll or crawl into view. 


 Note: For rolling credits, create a long text box by using 
the Vertical Type tool, and use alignment and leading to 
adjust the formatting. 


3. In the menu bar, select Text > Roll/Crawl Options. 


 The Roll/Crawl Options dialog box appears (Figure 23). 


4. Specify the appropriate direction and timing options, 
and then click OK. 


Note: You can specify a direction for crawling titles only. 


 
Figure 22 Title text default roll 


 


 
Figure 23 Roll/Crawl Options dialog box 
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How to add transitions 
By using transitions, you can phase out one clip while phasing in the next, or you can stylize the beginning or end of 
a single clip. A transition can be as subtle as a cross dissolve or quite emphatic, such as a page turn (Figure 1) or 
spinning pinwheel. You generally place a transition on a cut to include clips on either side—a double-sided 
transition, but you can also apply a transition to just the beginning or end of a clip—a single-sided transition. 


 
Figure 1 Page Peel transition between two clips (left) and Cross Dissolve transition at end of clip (right) 


For a transition to shift from one clip to the next, the transition must overlap frames from both clips. To achieve the 
overlap, transitions can use frames previously trimmed from the clips, if any exist (frames just past the In or Out 
point at the cut), or they can repeat the frames on either side of the cut. It’s important to remember that when you 
trim a clip, you don’t delete frames. The resulting In and Out points simply frame a window over the original clip. A 
transition uses the trimmed frames to create the transition effect (Figure 2), or, if the clips don’t have trimmed 
frames, the transition repeats frames (Figure 3). 


 
Figure 2 Transition using trimmed frames to shift to the next scene  


A. First clip with trimmed frames at end B. Movie containing clips and transition  
C. Second clip with trimmed frames at beginning 


 
Figure 3 Transition repeating frames for clips without trimmed frames  


A. First clip showing last frame repeated B. Movie containing both clips and transition  
C. Second clip showing first frame repeated 
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Where to access transitions 


You can access available transitions in the Transitions panel by clicking Transitions on the Action bar (Figure 4). In 
the Quick view, all the available transitions appear as thumbnails in the Transitions panel. The Quick view contains 
a subset of the transitions available in the Expert view. In the Expert view timeline, the transitions are organized into 
categories. You can narrow a search for transitions by choosing a transition type, such as Dissolve, from the 
Category menu. You can also search for a transition by typing its name in the search box. The Expert view has more 
transitions compared to the Quick view. 


 
Figure 4 Transitions panel 


Video transitions have animated thumbnail previews that show how they affect clips. Select a transition to set its 
thumbnail in motion. You can preview an animated thumbnail transition in the Transition panel without having to 
apply it to a clip.  


Note: Adobe Premiere Elements includes two audio transitions in the Crossfade category: Constant Power and 
Constant Gain. Though both provide fades, they differ slightly. Constant Power creates a smoother-sounding fade, 
while Constant Gain, though mathematically linear, often sounds abrupt. 


Specify a default transition 
The default transition is used in slide shows you create and files you import from Adobe® Photoshop® Elements. It 
is also used in motion backgrounds you create for DVD menus. The default transitions are Cross Dissolve for video 
or still images and Constant Power for audio. However, you can change these defaults. 


To specify a default transition: 


1. In the Quick view or the Expert view, click 
Transitions on the Action bar.  


       The Transitions panel appears (Figure 4). 


2. Right-click/ctrl-click the transition you want to be the 
default and choose Set Selected As Default Transition 
(Figure 5). (A gray outline marks the icon of the 
default transition.) 


 
 
 


 
Figure 5 Set Selected As Default Transition 
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Apply transitions in the Quick view timeline 
In the Quick view timeline, drop zones (indicated by vertical green lines) appear the moment you drag a transition. 
The drop zone let you easily apply transitions between clips (Figure 6).  
  


 
Figure 6 Transitions in the Quick view timeline 


  


To apply a double-sided transition in the Quick view timeline: 


1. In the Quick view, click Transitions on the Action bar. 


       The Transitions panel appears (Figure 7). 


2. Drag a transition from the Transitions panel to the 
drop zone between two clips in the Quick view 
timeline (Figure 6). 


       An icon of the transition appears on the right and left 
bottom corners of the clip to indicate it has been 
applied. In addition, the Transition contextual control 
appears (Figure 8). 


3. (Optional) Modify the properties of the clip, for 
example duration. Click the More button to further 
customize the transition and preview the changes. 


 
 
 


 
Figure 7 Transitions panel 


 


 
Figure 8 Transition contextual control 
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To apply a single-sided transition in the Quick view timeline: 


1. In the Quick view, click Transitions on the Action bar. 


       The Transitions panel appears (Figure 9). 


2. From the Transitions panel, select the transition you 
want to apply. 


3. Do one of the following: 


• If the clip has no clip adjacent to one side of it, 
drag the transition to the transition rectangle on 
that side of the clip. 


• If the clip is adjacent to another clip, drag the 
transition to the desired edge of the clip. In the 
Transitions contextual control set Alignment as 
Left Clip, Between Clips, or Right Clip. 


 
Figure 9 Transition contextual control 


Apply transitions in the Expert view timeline 
When applying transitions to the Expert view timeline, you can choose from alignment options, Left Clip, Between 
Clips, or Right Clip (Figure 10).  
 
 


 
Figure 10 Transitions in the Expert view timeline 


 


Apply a double-sided transition in the Expert view timeline 


To apply a transition between two clips in the Expert view timeline the clips must be on the same track, with no 
space between them. 


If a double‑sided transition must use repeated frames (rather than trimmed frames), the transition icon contains 
additional diagonal lines. The lines span the area where it has used the repeated frames. 
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To apply a double-sided transition in the Expert view timeline 


1. In the Expert view, click Transitions on the Action 
bar.  


       The Transitions panel appears (Figure 11). 


2. From the Transitions panel select the category 
containing the transition you want to apply. 


3. Drag the transition from the Transitions panel to the 
cut between two clips in the Expert view timeline, and 
release the mouse button when one of the following 
alignment icons appears: 


 Start At Cut icon : Aligns the beginning of the 
transition to the beginning of the second clip. 


 Center At Cut icon : Centers the transition 
over the cut (Figure 12). 


 End At Cut icon : Aligns the end of the 
transition to the end of the first clip. 


       Note: Pressing Ctrl while dragging a transition lets 
you select Start At Cut, Center At Cut, or End At Cut 
by slowly dragging the transition left and right over 
the cut 


 
 


 
Figure 11 Transitions panel 


 


 
Figure 12 Dragging a transition onto the 
Timeline, with Center At Cut icon visible at 
pointer 


Apply a single-sided transition in the Expert view timeline 


When you create a single‑sided transition, whatever is below the transition in the Expert view timeline appears in 
the transparent portion of the transition. For example, If you want the clip to transition to black, it must be on Track 
1 or have no clips beneath it. If the clip is on a track above another clip, the clip on the lower track appears in the 
transition, so the transition will appear to be double‑sided. 


To apply a single-sided transition in the Expert view timeline: 


1. In the Expert view, click Transitions on the Action 
bar.  


       The Transitions panel appears (Figure 11). 


2. From the Transitions panel select the category 
containing the transition you want to apply. 


3.    Do one of the following: 


• If the clip has no clip adjacent to one side of it, 
drag the transition to the transition rectangle on 
that side of the clip. 


• If the clip is adjacent to another clip, drag the 
transition to the desired edge of the clip. In the 
Transitions contextual control set Alignment as 
Left Clip, Between Clips, or Right Clip. 
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Previewing an applied transition 
In the Quick view timeline or the Expert view timeline, move the current-time indicator to the left of the transition, 
and then click the Play button in the Monitor panel. You can also preview a particular frame of the transition in the 
Monitor panel, drag the current-time indicator to the desired frame (Figure 13). 
  


 
Figure 13 Drag the current-time indicator to preview an applied transition 
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Controls and options for adjusting transitions 
All transitions have properties that you can adjust in the Transitions contextual control. Common properties are the 
location of the center point, the start and end values, the border, and the anti-aliasing quality setting. (For some 
transitions, you can also change the orientation.) The following list describes the most common controls and options 
you can use to adjust transition properties.  


To open the Transitions contextual control, double-click the a transition in the Quick view timeline or the Expert 
view timeline (Figure 14). Click the More button to expand the options in view.  


• Duration Sets the duration of the transition. The default duration is one second. 


• Alignment Controls how the transition is aligned between clips. By default, transitions are centered between 
clips. 


• Start/End Points Set the percentage of the transition that is complete at the start and end of the transition.  


• Show Actual Sources Displays the starting and ending frames of the clips. 


• Reverse Plays the transition backward. For example, the Clock Wipe transition plays counterclockwise. 


• Anti-Aliasing Quality Adjusts the smoothness of the transition’s edges. 


• Custom Changes settings specific to the transition. Most transitions don’t have custom settings.. 


 


  
Figure 14 Transitions Adjustments 


More / Less button 







Adobe Premiere Elements 11 guide 


8 How to add transitions © 2012 Adobe Systems Incorporated 


To adjust the transition duration: 


You can edit a transition’s duration by dragging the end 
of the transition in either the Quick view timeline or the 
Expert view timeline. You can also use the Transition 
contextual control to edit the duration of a transition. 


Select the transition in the Quick view timeline or the 
Expert view timeline and do one of the following: 


 Position the pointer over the end of the transition 
until the Trim-In icon  or the Trim-Out icon 
appears. Drag the Trim-In icon or the Trim-Out 
icon to the left or right to adjust the duration 
(Figure 15). 


 Double-click the transition and radjust the duration 
using the Transition contextual control. 


Note: Lengthening a transition’s duration requires that 
one or both clips have enough trimmed frames to 
accommodate a longer transition. 


 
Figure 15 Trim-In icon and time information in 
the Timeline 


 


To adjust the center point of a transition: 


1. Select the transition in the Timeline. 


2. In the Transitions view of the Tasks panel, click the Edit 
Transition button. 


3. In the preview area in the Properties view, drag the 
small circle to reposition the transition center 
(Figure 16). 


Note: Not all transitions have an adjustable center point. 


 
Figure 16 Default center (left) and repositioned 
center (right) 
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How to add video effects 


You can use effects to add a creative flair to your movie or to fix exposure or color problems, edit sound, or 
manipulate images. Adobe Premiere Elements comes with preset effects with which you can quickly and easily 
apply a preconfigured effect to footage. You can use included presets, create your own presets, or adjust and animate 
values as desired. You can animate the effects you add to clips by using presets that have predefined keyframe 
values, or you can create keyframes with custom values. Presets provide a quick, easy way to animate effects, while 
custom keyframes let you create more precise and complex animations. 


About effects 
After you’ve assembled a movie (arranging, deleting, and trimming clips), you can add polish to it by applying and 
refining clip effects (Figure 1). For example, an effect can alter the exposure or color of footage, manipulate sound, 
distort images, or add an artistic feel. All effects are preset to default settings so you can see the results of the effect 
as soon as you apply it. You can change these settings to suit your needs when you apply the effect. 


You can also use effects to rotate and animate a clip or to adjust its size and position within the frame. Adobe 
Premiere Elements also includes several preset effects you can use to quickly alter your footage. Most effects have 
adjustable properties; however, some effects, such as Black & White, do not. All effects are reversible, so if you 
don’t like the results of an effect, you can remove the effect at any time. 
 


 


 
 


 


Figure 1 Applied Effects panel 
  


This guide examines how to apply effects to a clip—including how to use the cartoon special effect and how to use 
the Pan and Zoom tool. The cartoon effect applies a cartoon-like style to scene (or part of a scene) for an 
entertaining special effect. Use the Pan and Zoom tool to apply documentary style movement to video and still 
images. 


Refine effect controls 


Delete Effect Toggle effect on or off Preview window 
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Find, apply, and preview effects 
Available effects are listed in the Effects panel. The Effects panel works differently in the Quick and Expert views. 
In Quick view, a selection of the most popular effects are presented. In Expert view, an expanded list of effects is 
available. In this section, you will use the Expert view to find, apply and preview effects. 


Effect presets (preconfigured effects) are stored in the Presets folder. If you create your own effect presets, they are 
stored in the My Presets folder. Within each folder, effects are grouped by type in nested folders. For example, the 
Blur And Sharpen folder contains effects that alter the clarity or focus of an image, such as Fast Blur and Sharpen. 


When you apply an effect to a clip, the effect is set to default values and is active for the duration of the clip. After 
you apply an effect, you can adjust its properties by clicking the Applied Effects button in the Tasks panel. You can 
make an effect start and stop at specific times or adjust the values of the effect over time by using keyframes. 


You can apply multiple effects to a clip, and you can apply the same effect numerous times to the same clip with 
different settings. Keep in mind, however, that the more effects you add, the more time it takes to render the final 
movie. If you decide an effect is not suitable for your project, you can easily delete it in the Applied Effects panel. 


To apply and preview a video effect: 


1. Open an Adobe Premiere Elements project. 


2. Click the Expert tab at the top of the workspace. 


3. Click the Effects button in Action Bar to open the 
Effects panel. 


4. Click the Effect category menu to reveal the preset 
effects categories (Advanced Adjustments, Blur 
Sharpen, Channel, and so on) (Figure 2). 


5. Click an Effect category to view its contents. 


         


 


 
Figure 2 Selecting an effect category from the 
category menu in the Effects panel 


Effects 
category 
menu 
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6. Select an effect from the Effect panel and drag the effect 
to the clip in the Timeline, or the Monitor panel 
(Figure 3).  


Note: To select nonconsecutive clips, Shift-click each 
clip. To select consecutive clips, click in the My Projects 
panel and drag a marquee around the clips you want. 


7. Click the Play button in the Monitor panel to preview 
the clip with the effect applied. 


8. To remove an effect, select the effect at the top of the 
Effects view, and then click the Trash Bin button 
(Figure 4).  


 
Figure 3 Drag and drop an effect to the Monitor 
panel 


 


 
 


Figure 4 Applied Effects panel 


 


 


Delete Effect button 
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Adjusting effect properties 
Use the Applied Effects panel (Figure 5) to adjust effect properties. Open the Applied Effects panel by clicking the 
Applied Effects button (or by choosing Window > Applied Effects). 
 


 


 
 


Figure 5 Monitor and Applied Effect panels 


 


To adjust a video effect: 


1. In the Quick view Timeline, or Expert view Timeline, 
select the clip that contains the effect you want to adjust. 


2. Click the Applied Effects button. 


3. In the Applied Effects panel (Figure 5), expand the 
effect and do any of the following: 


• Drag the underlined value left or right. 


• Click the underlined value, enter a new value, and 
press Enter (Windows) or Return (Mac OS). 


• Drag the value slider left or right. 


• Drag inside the angle control area. After you’ve 
clicked inside the angle control, you can drag 
outside of it to quickly change the values. 


 


 


 


 


 


Preview window 


Underlined value Value slider 
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4. If an effect is color-based, do either of the following: 


• If the color swatch is available, select a color in the 
Color dialog box, and then click OK. 


• If the Eyedropper tool is available, position it on the 
desired color anywhere on the screen, and then click 
to select the color. 


5. Sometimes, reordering effects can lead to an interesting 
effect in itself. To reorder effects, click an effect name in 
the Effect Properties view and drag it to a new location 
in the list. A black line appears when the effect is above 
or below another effect (Figure 6). When you release 
the mouse button, the effect appears in the new position. 


6. Preview your changes in the Monitor panel (Figure 7). 


Note: If you have a DV camcorder, you may be able to 
preview effects on a TV monitor. Connect the computer 
to your DV camcorder’s FireWire™ jack and connect 
the camcorder’s audio and video outputs to the TV. 
Previewing on a TV monitor is especially helpful for 
changes to color. 


 


 


 
Figure 6 Dragging an effect to a new location 


 


 
Figure 7 Preview the effect changes in the 
Monitor panel 
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Panning and zooming video and stills 
Video and film techniques, such as how you frame a shot, can greatly influence the mood and meaning of your 
story. Camera movement, such as zooming and panning, are used to focus the viewer’s attention or to build curiosity 
and suspense by slowly revealing objects hidden beyond the edge of the frame. 


This technique is used in historical documentaries where film or video material is not available. Action is given to 
still photographs by slowly zooming in on subjects of interest and panning from one subject to another. For 
example, in a photograph of a hockey team, one might slowly pan across the faces of the players and come to a rest 
on the player the narrator is discussing. The zooming and panning across photographs gives the feeling of motion, 
and keeps the viewer visually entertained.  


You can use the Photoshop Elements Zoom and Pan tool to add these effects to both video and still images during 
the editing process. 


To zoom or pan a clip in the Timeline: 


1. In the Quick view Timeline, or Expert view Timeline, 
select the video or picture that you want to zoom or pan. 


2. Click Tools button to open the Tools panel, and scroll 
down and click the Pan & Zoom tool (Figure 8). 


 The Pan and Zoom window opens with two frames 
created automatically (Figure 9). By adjusting the size 
and position of each frame, you define the change, or 
movement, that occurs. The Effect Timeline shows the 
duration of the effect. Green represents when the clip is 
still (no motion). Blue represents when the movement 
occurs between frames.  


 
Figure 8 Pan and Zoom tool 


 


 
Figure 9 Pan and Zoom window 


Frames 


Frame 
thumbnails 


Effect 
Timeline 
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3. Click Play Output to preview the default effect. 


4. Click Exit Preview or press Esc to exit the preview 
window and return to the Pan and Zoom window. 


 Most likely, you will need to adjust the position of the 
frames. In this example, the effect begins full screen for 
one second (frame 1) and then takes forty seconds to 
zoom into the center of the picture (frame 2).  The zoom 
should end on a close up of the wolf’s face instead 
(Figure 10).   


 Note: To reverse the effect (begin zoomed in and slowly 
zoom out), you can rearrange the frame thumbnails by 
dragging. 


5. Position the pointer over the center of the frame 2 box 
and drag it to reposition the end point of the zoom effect 
(Figure 11). 


6. To change the size of a frame, position the pointer along 
any corner handle and drag (Figure 12). 


 


 


 


 
Figure 10 Forty second zoom effect  


 


 
Figure 11 Adjusting the position of the frame 


 


 
Figure 12 Adjusting the size of the frame 
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7. To change the timing of the effect, select the frame and 
click its timing icon (Figure 13).  


8. In the Pan (or Zoom) Time dialog box, enter the new 
duration for the effect and click OK. 


9. To add additional movement to the same clip, click New 
Frame in the Pan and Zoom window. 


 A new frame is added to the window and a new 
thumbnail appears (Figure 14).  


10. Drag the new frame to position the end point of the new 
frame.  


 In this example, the clip begins full screen in frame 1, 
zooms into a close up of the dog on the left, holds for 
one second, and then pans to the dog on the right 
(Figure 15). 


11. In the Effect Timeline, drag the current time indicator to 
the beginning of the effect and click Play Output to 
preview the effect. 


12. Click Exit Preview or press Esc. 


13. When you are satisfied with the effects on the current 
clip, click Done. 


 


 


 


 


 


 
Figure 13 Pan Time dialog box  


 


 
Figure 14 An effect with three frames 


 


 
Figure 15 Panning to the right 


 


Timing icon 
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To zoom or pan using Face Frames: 


1. In the Quick view Timeline, or Expert view Timeline, 
select the video or picture that you want to zoom or pan. 


2. Click Tools button to open the Tools panel, and scroll 
down and click the Pan & Zoom tool (Figure 16). 


3. Click the Face Frames button. 


 The picture is analyzed and additional close up frames 
are created for each face that is recognized in the photo 
(Figure 17). 


 The effect will begin wide screen and then zoom into a 
face. After holding for one second, the effect pans to 
another face in the image. You can rearrange the order 
of each frame by dragging the thumbnails below the 
Effect Timeline. 


 Photoshop Elements assumes you want to feature each 
face in the image for equal amounts of time. You can 
ignore specific people in the photo by selecting a 
thumbnail and pressing Delete. 


4. Position the current time indicator at the beginning of 
the Effect Timeline and click Play Output to preview the 
effect. 


5. Click Exit Preview or press Esc. 


6. Size and position each frame as needed. 


7. Adjust the duration for each zoom or pan as needed. If 
your project includes a narration sound track, you can 
time the effects to sync the narration. 


8. Click Done to apply the effect. 


 


 


 


 
Figure 16 Pan and Zoom tool 


 


 
Figure 17 Face frames 
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How to edit clips 


Editing clips includes previewing and trimming them to eliminate unnecessary material. It could also include 
revising clip properties such as speed, direction, and duration. If you have media clips generated by other programs, 
you can also edit them in their original applications from within Adobe Premiere Elements. 


This guide covers the following topics: 


• Working with the Preview window 


• Trimming a clips  


• Splitting clips  


• Using Freeze Frame to export images 


The Preview window 
Although the Timeline is the primary workspace for assembling clips into movies, the Preview window (Figure 1) 
provides a helpful workspace for viewing clips, setting their In and Out points, and adding markers to clips and 
movies. Double-click any clip in Project view to launch the Preview window. The time ruler graphically represents 
the full duration of a clip or movie. 
  


 
 
 


Figure 1 The Preview window 


 


  


Current time Playback controls Time ruler 
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Zooming into or out of the timeline 
When you zoom in on the Quick view timeline or Expert view timeline, Adobe Premiere Elements magnifies the 
timeline around the current-time indicator, letting you examine smaller increments of media. You can also zoom in 
as you add a clip to the timeline, magnifying the location around the pointer rather than the current-time indicator. 
This technique lets you better see the placement of the insertion before you release the mouse. In contrast, zooming 
out shows more of the timeline, giving you a visual summary of the movie. 


 To zoom into or out of the timeline:  


Make sure you have at least one clip in the timeline. To 
zoom in and out of the Timeline, do one of the following: 


• Press the Plus (+) key to increase the zoom factor or 
press the Minus (–) key to decrease it until you have 
zoomed as far as you want to go. 


• To zoom in on the timeline, drag the Zoom slider to 
the right or click the Zoom In button. 


• To zoom out of the timeline, drag the Zoom slider 
to the left, or click the Zoom Out button (Figure 2). 


Note: To zoom out so the entire length of the movie is 
visible in the timeline and then press the Backslash (\) key. 
You can also zoom in and out by pressing the Plus (+) or 
Minus (–) keys on the keyboard (not the numeric keypad). 


 


 
Figure 2 Zoom controls in the Timeline 


To position the current-time indicator:  


In either the Preview window or the Quick view timeline or 
Expert view timeline, do any of the following. 


• Drag the current-time indicator (Figure 3). 


• Click the time ruler where you want to position the 
current-time indicator. 


• Press Shift while dragging the current-time 
indicator to snap it to the edge of the closest clip or 
marker (Expert view timeline only). 


• Drag the time display to the desired time value 


• Click the time display, type a valid time, and then 
press Enter. (You don’t need to type leading zeros, 
colons, or semicolons. However, be aware that 
Adobe Premiere Elements interprets numbers less 
than 100 as frames.) 


Note: You can use the Home or End keys on the keyboard to 
skip back to the beginning or ahead to the end of the movie. 
The Page Up and Page Down keys go to the previous and 
next clips. The Right Arrow and Left Arrow keys move the 
current-time indicator forward or back a frame, and pressing 
Shift+Right Arrow or Shift+Left Arrow moves the indicator 
in increments of five frames.  


 
 


 
 
 
Figure 3 The current-time indicator  


 


Time display Current-time indicator 
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About trimming and retrieving clips 
When you build a movie, you rarely use an entire clip. To define the frames you want to use, set In and Out points 
(Figure 4). The In point is the first frame of the clip you want to use. The Out point is the last frame of the clip you 
want to use. 


Setting In and Out points does not delete frames from the hard drive. Instead, it isolates the portion you want 
included in the movie. In and Out points act like a window over the clip, showing only the frames from the In point 
to the Out point. You can move In and Out points as needed to regain any frames you might have trimmed. 
  


 
 


Figure 4 In and Out points serve as a window over a clip 
 


You can trim frames from either end of a clip. To trim frames from the middle of a clip, first split the clip (which 
creates two parts of the original clip). Then, trim the unwanted frames from the end of the first new clip or the 
beginning of the second. 


You can trim a clip in the Preview window, the Monitor panel, the Quick view timeline, or the Expert view timeline. 
You can retrieve frames from source clips (clips not yet placed in the Quick view timeline or the Expert view 
timeline) using the Preview window. You can retrieve frames from clips in the Quick view timeline or the Expert 
view timeline. 


Trim a clip from the Quick view timeline 


You can directly trim clips in the Quick view timeline. 


You can also retain material at the beginning and end of a clip for your movie, but remove material from its middle. 
Split the clip right before the unwanted section begins, to create two clips. Then, trim the unwanted material from 
the beginning of the second clip. 


To trim a clip from the Quick view timeline: 


1. Select the clip in the Quick view timeline. 


2. Position the pointer over the edge of the clip you want to 
trim until the correct icon appears: 


• Trim-In icon  to trim the beginning of a clip 
(Figure 5). 


• Trim-Out icon  to trim the end of a clip. 


3. Drag the trim handles to the desired frame. The Monitor 
panel displays the frames as you drag, also showing the 
frame from the adjacent clip (if any). Subsequent clips 
in the track shift in time to compensate for the edit, but 
their durations remain unchanged 


 


 
Figure 5 Trim-In icon at the beginning of a clip 


Trimmed frames Trimmed frames In point Out point 
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To remove frames from the middle of a clip in the Quick view timeline: 


1. In the Quick view timeline, select the clip containing 
unwanted material. The clip appears in the Monitor 
panel. 


2. Drag the current-time indicator on the Quick view 
timeline to the frame where the unwanted material 
begins. 


3. Click the Split Clip button on the current-time indicator 
(Figure 6). 


  The original clip is split into two clips in the Quick view 
timeline (Figure 7). 


4. Double-click the clip to the right of the split. This opens 
the clip in the Preview window (Figure 8). 


5. In the Preview window, drag the current-time indicator 
to the frame just after the last frame of unwanted 
material. 


6. Click the Set In Point button. This trims the unwanted 
material from the beginning of the second clip and 
shortens the clip in the Quick view timeline, leaving a 
gap between it and the clip before. 


       The unwanted material is removed from the beginning 
of the second clip (or end of the first clip, if you chose to 
edit that clip). The gap created between the first and 
second clips is automatically closed. 


7. Right-click/ctrl-click in the gap in the Quick view 
timeline, and then click Delete And Close Gap. 


 
Figure 6 Split Clip button button on the current-
time indicator 


 


 
Figure 7 Split clip 


 


 
Figure 8 Trimmed clip in Preview window 


Trim in the Expert view timeline 


You can remove or regain trimmed frames from either end of a clip by dragging the clip’s edge in the Expert view 
timeline. To help you locate the desired frame, the Monitor panel displays it at the changing In or Out point of the 
clip as you drag. If another clip is adjacent to the edge you’re trimming, the Monitor panel displays the frames of 
both clips side by side. 


The frame on the left (the Out point) is earlier in time, and the frame on the right (the In point) is later in time. 
Subsequent clips, as well as blocks of empty space, in the Expert view timeline shift as you drag the clip’s edge. 
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A tool tip displays the number of frames you are trimming as you trim them. This window displays a negative value 
if you drag the clip’s edge toward the beginning of the movie. 


It displays a positive number if you drag toward the end of the movie. You can tell whether you have trimmed a clip 
by looking for a small gray triangle in the top corner at either end of the clip in the Expert view timeline. The 
triangle indicates you have not trimmed that edge. 


For linked clips (video that includes a soundtrack), dragging the edge of one clip changes the In or Out points of 
both clips. Sometimes you want to trim linked clips independently to create split edits (also known as L‑cuts and J‑
cuts). Pressing Alt when you trim allows you to set the In and Out points of the video and audio separately.  


You can also retain content at the beginning and end of a clip for your movie and remove content from its middle. 
Split the clip before the unwanted section begins, and then trim the unwanted material from the beginning of the 
second clip resulting from the split. 


To trim clips in the Expert view timeline: 


1. Position the pointer over the edge of the clip you want to 
trim until the correct icon appears: 


• Trim-In icon  to trim the beginning of a clip 
(Figure 9). 


• Trim-Out icon  to trim the end of a clip. 


2. Drag the edge to the desired frame. The Monitor panel 
displays the frames as you drag, also showing the frame 
from the adjacent clip (if any). Subsequent clips in the 
track shift in time to compensate for the edit, but their 
durations remain unchanged. 


Note: You cannot drag the In point of a clip to the left 
past the edge of an adjacent clip. 


 
Figure 9 Trim-In icon at the beginning of a clip 


To remove frames from the middle of a clip in the Expert view timeline: 


1. In the Expert view timeline, drag the current-time 
indicator to the frame where the unwanted section of a 
clip begins. 


       The frame appears in the Monitor panel. 


2. Click the Split Clip button on the current-time indicator 
(Figure 10). 


This splits the clip at the point selected. 


3. Double-click the clip to the right of the split. This opens 
the clip in the Preview window. 


Note: You can also open the clip to the left and make 
the following edits by setting a new Out point. 


4.    In the Preview window, drag the current-time indicator 
to the frame just after the last frame of unwanted 
material. 


5.    Click the Set In Point button. This trims the unwanted 
material from the beginning of the second clip and 
shortens the clip in the Expert view timeline, leaving a 
gap between it and the clip before. 


 


 
Figure 10 Split Clip button on the current-time 
indicator 
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6.    Right-click/ctrl-click in the gap in the Expert view 
timeline, and then click Delete And Close Gap 
(Figure 11). 


 
Figure 11 Split Clip context menu 


Trim in the Preview window 


You can preview any clip and set new In and Out points for it before adding it to the Expert view timeline or the 
Quick view timeline. You might, for example, preview your clips to determine their quality and trim unusable parts 
before arranging them. You can preview and trim clips in the Preview window. 


Trimming a clip in the Preview window sets its In and Out points for all subsequent instances in the Expert view 
timeline or the Quick view timeline. It does not change the In and Out points of clip instances that are already in the 
Expert view timeline or the Quick view timeline. To let all clip instances use the same In and Out points, set them 
before placing the clip in either timeline. 


Trim a clip in the Preview window 


You can trim a clip in the Preview window before placing it in the Expert view timeline. Trimming in the Preview 
window does not affect instances of the clip that are already in the Expert view timeline or the Quick view timeline. 


Once a clip is in a movie, you can reopen it in the Preview window to change its In and Out points for subsequent 
instances. You can either regain frames previously trimmed or trim additional frames. 


To trim a clip in the Preview window: 


1. In the Project Assets panel, double-click a clip. The 
Preview window appears. 


2. To trim the clip, do any of the following in the Preview 
window: 


• To set a new In point, either drag the In point 
handle or drag the current-time indicator to the 
desired location (Figure 12) , and click the Set In 
button. 


• To set a new Out point, either drag the Out point 
handle or drag the current-time indicator to the 
desired location, and click the Set Out button. 


3.     Click the Close button in the Preview window. 


Subsequent clip instances you drag to the Expert view 
timeline assume the In and Out points of the trimmed clip.  


Figure 12 Dragging the In point in the Preview 
window 
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Using Smart Trim 
You can create a refined good-quality video file by removing unwanted sections. Adobe® Premiere® Elements 11 
enables you to efficiently handle blurred, shaky, and unwanted low-quality and low- interest sections of your video 
file. You can easily and quickly edit and fine-tune the video files. 


Smart trimming enables you to trim the low-quality sections of a video file. You can trim clips from the Quick view 
timeline or the Expert view timeline. You can specify the options that determine the trimmable sections.  


To use Smart Trim: 


1. To enable Smart Trim, click Tools on the Action bar and 
then select Smart Trim from the Tools panel 
(Figure 13). 


2. (Optional) Click the Smart Trim Options button on top. 
In the Smart Trim Options dialog (Figure 14), use the 
slider to specify the Quality and Interest options. The 
values set here determine the trimmable sections. If you 
do not set the options here, default settings are used. 


       Premiere Elements analyzes the clip, and highlights the 
sections of the clip that need trimming. The highlighted 
sections depend on the values set for the Quality Level 
and Interest Level options. Striped patterns are used to 
highlight the trimmable sections. 


3. (Optional) View the bad-quality tags that 
Premiere Elements applied on the trim sections by 
hovering the mouse over the Smart Trim section of the 
clip (Figure 15). 


4. To select trim sections in a clip, do one of the following: 


• Double-click the clip in the Expert view timeline to 
select all the trimmable sections in a single clip. 


• To select all the trimmable sections in multiple 
clips, drag a marquee around the selected clips in 
the Expert view timeline. Right-click/ctrl-click the 
trim sections, and choose Select All. 


• To select all the trimmable sections in multiple clips 
in the Quick view timeline or the Expert view 
timeline, select Ctrl-A. Right-click/ctrl-click a 
section > Select All. 


       The selected trim sections are highlighted. When you 
select a trimmable section, all trimmable sections turn 
into blue-striped sections. 


        Note: To choose selected trim sections from multiple 
clips, first select the clips, and select the trim sections. 


 


 
Figure 13 Tools panel 


 


 
Figure 14 Smart Trim Options dialog box 


 


 
Figure 15  Problem segment identified by Smart 
Trim 
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5. Right-click/ctrl-click a trimmable section (the blue-
striped region) (Figure 16). The following options are 
displayed: 


       Trim Enables you to trim the selected trimmable section. 


       Keep Enables you to retain the selected trimmable 
section. 


       Select All Selects all the trimmable sections in the 
current selection. 


       Smart Trim Options Displays the Smart Trim options. 


6. Select Trim to trim the trimmable region, or select Keep 
to retain the trimmable section. You can also trim clips 
using the Delete key on the keyboard. 


7. (Optional) To undo the previous trim action, right-
click/ctrl-click the clip in the Expert view timeline, and 
select Undo Smart Trim. 


 
Figure 16 Tools panel 


 


 


Split clips 
You might want to apply different effects to different parts of a clip. For example, to speed up the first part but leave 
the second part at normal speed. To do this, you cut a clip into separate pieces, and then apply effects and transitions 
to those pieces. You can split a clip in a movie by using the Split Clip button on the current-time indicator. It cuts 
one or more selected clips at the current‑time indicator. 


Splitting a clip divides it into two parts, creating a new and separate instance of the original clip. If the clip is linked 
to another clip, a new instance of the linked clip is created as well. 


The two resulting clips, when combined, represent the original clip. The resulting clips are full versions of the 
original clip, but with the In or Out points changed to match the location marked by the tool. You can select and 
delete these clips. 


Note: If you want to change effect settings over time, you don’t have to split the clip. You can apply keyframes to a 
single clip instead. 


Split a clip 


You can split a clip at any frame, creating one clip that ends, and another that begins, at that frame. You can edit the 
two resulting clips as you would any other clips. 


To split a clip: 


1. Select a clip in the Quick view timeline or the Expert 
view timeline. 


2. Drag the current-time indicator to the frame where you 
want to create the split. 


3. On the current-time indicator, click the Split Clip button 
(Figure 17). 


Two new clips take the place of the original clip: one 
ending and one beginning at the location of the current-
time indicator. 


 
Figure 17 Split Clip button  
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Two new clips take the place of the original clip: one 
ending and one beginning at the location of the current-
time indicator (Figure 18). 


 
Figure 18 Split clip  


Split a layered clip 


You can simultaneously split two or more layered clips (clips that overlap in the Expert view timeline). 


To split a layered clip: 


1. In the Expert view timeline, drag a marquee to select 
clips, on different tracks, that overlap at a point in time 
(Figure 19). 


2. In the Expert view timeline, drag the current-time 
indicator to the place where you want to make the split. 


3. On the current-time indicator, click the Split Clip button. 


 


 
Figure 19 Select multiple tracks 


Export a video frame 
You can grab a single frame from a video clip to use as a still image in your current movie or to save as a still on 
your hard drive for use elsewhere. For example, you can use a still in your movie to show a character start an action, 
but then stop mid-action, frozen on the screen. 


To export a video frame: 


1. Select a clip in the Quick view timeline or the Expert 
view timeline. 


2. In the Quick view timeline or the Expert view timeline, 
drag the current-time indicator to the frame you want to 
grab. 


       The Monitor panel shows the frame at the location of the 
current-time indicator. 


3. In the Action bar, click Tools and select the Freeze 
Frame option from the Tools panel (Figure  20). 


         
Figure 20 Tools panel 
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       The frame appears in the Freeze Frame dialog box 
(Figure  21). 


       Note: If you have Adobe Photoshop Elements installed, 
and want to edit the still image in Photoshop Elements, 
choose Edit In Photoshop Elements After Inserting. 


4. Do one of the following: 


• To export the frame as a still image file, click 
Export. In the Export Frame dialog box, give the 
image file a name and location, and click Save. 


• To insert the frame as a still image directly into the 
movie at the current-time indicator, click Insert In 
Movie. Use the Freeze Frame Duration time slider 
to adjust the length of the still image in the movie. 


 


 
Figure 21 Freeze Frame dialog box 
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How to import video 


There are four basic methods for adding media to your projects: capturing from tape or live sources, importing files 
from other types of storage, adding from the Organizer workspace, or recording narrations from a microphone. 


When you add media files to your project, they are added to the Project view and the Organizer workspace. Each file 
is represented by a thumbnail, called a clip. Clips, whether they contain audio, video, or still images, are the building 
blocks of your movies. 


Common sources of media files 
To get new media into your project, click the Add Media button (Figure 1).  
  


 
Figure 1 Add Media panel 


  


Use any of the following options: 


• Elements Organizer Adds video and images from the Organizer workspace. In Quick view, you add files 
directly to the Sceneline by dragging and dropping from the Organizer. In Expert view, you can drag and 
drop files from the Organizer into the  Project Assets view (Figure 2). 
  


 
Figure 2 Project Assets view 
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• Videos From Flip Or Cameras Imports media from devices that store video files in flash memory or on a 
disk.  


• DV Camcorder Captures video from a DV camcorder connected by FireWire or USB 2.0. This option 
opens the Capture window. 


• HDV Camcorder Captures video from an HDV camcorder connected by FireWire or USB 2.0. This option 
opens the Capture window. 


• DVD Camcorder Or Computer Drive Imports video from your DVD drive, or a DVD in a camcorder 
connected by USB. You can import AVCHD from a DVD Camcorder. This option opens the Video 
Importer dialog box. 


• Webcam Or WDM (Webcam in Mac OS) Captures video from a webcam or WDM-compatible capture 
device. This option opens the Capture window. 


• Photos From Cameras Or Devices Imports photos from a still camera, mobile phone or other device 
connected by USB. This option opens the Video Importer dialog box. 


• Files And Folders Imports video files, photos, and audio files from your computer’s hard drive. 


When you add media files to Premiere Elements, they are added to the Quick view timeline and the Expert view 
timeline. In addition, they are added to the Project Assets panel in the Expert view. 


File types you can import 
Your choice of footage to include in your movie is not limited to the clips you capture. You can use other image, 
video, and audio files that reside on your computer. You only need to add them to your Adobe Premiere Elements 
project to begin working with them. In some cases, added files can retain a link to the Adobe application in which 
they were created. This allows you to open the file’s original application from within Adobe Premiere Elements, 
make changes, and immediately see the results in Adobe Premiere Elements. 


Except as noted, you can import the following file types by using the Add Media button.  


Video file types 


• AVI Movie (.avi) 


• Shockwave flash (.swf) 


• RAW (.raw) 


• Filmstrip (.flm) 


• MPEG Movie (.mpeg, .mpe, .mpg, .m2v, .mpa, .mp2, .m2a, .mpv, .m2p, .m2t, .ts, .ac3, .vob, .mod, .m2ts, 
.mts, .m1v, .mp4, .m4v, .mov, .acc, .3gp, .avc, .264, .tod, .f4v) 


• Windows Media (.wmv, mwa, .asf, .asx) 


• QuickTime Movie (.mov, .3gp, .3g2, .mp4, .m4a, .m4v, .TSDR, .dif, .dv, .flc, .fli, .m15, .m1a, .m1s, .m1v, 
.m4a, .m4v, .m75, .mp4, .mpa, .mpeg, .mpg, .mpg4, .mpm, .mpg) 


• DV Stream (.dv) 


Note: To import video from mobile phones (.3gp and .mp4), you must have the most recent version of QuickTime 
installed on your computer. 
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Capturing video 
Use the Capture window to monitor the video and access all of the capture commands (Figure 3). Adobe Premiere 
Elements automatically detects the attached capture device and provides an alert in case of a mismatch. 


This panel includes a video preview area, recording controls, a disk-space indicator, and a timecode display. On the 
right side of the Capture window, you can specify capture settings. 


To open the Capture window, click Project in the Tasks panel, click Add Media , and select one of the following: 


• DV Camcorder 


• HDV Camcorder 


• Webcam Or WDM Device 


Capturing footage with device control simply means using the controls (Play, Fast Forward, Rewind, Pause, Stop, 
Record, and so on) in the Capture window to control your device, instead of using the controls on the device. Device 
control is a convenient way to locate and capture scenes. 


 


 


 
 


 


Figure 3 Capture window 


Adding files from tape camcorders 


Capturing involves recording video and audio directly to a hard drive from a DV or HDV camcorder, webcam, or 
other WDM (Windows Driver Model) device. Adobe Premiere Elements automatically detects the attached capture 
device and sets all capture settings accordingly. The Capture window provides controls that let you remotely control 
your device, making it easy to play, capture, pause, and stop the video on your device.  


If you are capturing only a portion of a tape, as opposed to capturing an entire tape, capture at least 3 seconds of 
additional footage (called handles) at both the beginning and end of the segment to provide a margin of error during 
capture. Handles also allow for cleaner transitions and more flexibility when you trim your clips. 


Capture source menu Preview area Capture window  menu 


Capture 
settings 


Time captured Time on tape Device controls Previous and 
next  scene 
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To capture clips from a camcorder 


1. Do one of the following, depending on the capture 
device you are using: 


• Connect the DV camcorder , HDV camcorder, 
Webcam, WDM device, or analog device to your 
computer by connecting a cable to the USB 2.0 port 
or 1394 (FireWire) port.  


• Consult the owner’s manual for your computer for 
details on these and other options. 


2. Turn on the camcorder and set it to playback mode, 
which may be labeled either VTR, VCR, or Play. You 
can also keep it in recording mode. 


3. Click Project, and then click Add Media  (Figure 4).  


 A list of devices appears. 


4. Click DV Camcorder, HDV Camcorder, or Webcam Or 
WDM Device. 


 Adobe Premiere Elements automatically detects your 
attached device and provides an alert in case of a 
mismatch.  


 The Capture window opens.  


If you have more than one device attached, select the 
device from the Capturing Source menu. 


5. Enter a name for the clip. 


6. Browse for a location to save the clip. 


7. Set the following options as desired in the Capture 
window (Figure 5): 


• Capture Video or Audio: By default, both are 
selected. 


• Capture To Timeline: Clips are automatically added 
to the Timeline after you finish capturing them 


• Split Scenes: Capture is split into clips by either 
Timecode or Content. 


8. Using the controls in the Capture window, rewind or 
advance the tape to the desired position. 


 
Figure 4 List of import devices 


 


 
Figure 5 Options for capturing video from a 
camcorder 
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9. Click the Capture button.  


 Premiere Elements begins capturing video from the 
camcorder (Figure 6). 


10. When you have finished capturing, click the Pause 
button.  


 Depending on the options you selected, the Auto 
Analyzer runs and the captured clips are added to the 
Organize workspace and/or the Timeline. 


 


 
 


Figure 6 Capture window 


Add videos using the Video Importer 
Many types of devices other than DV camcorders record and store video. Using the Video Importer (Figure 7), you 
can import files from tapeless camcorders and mobile devices, and from removable media, such as DVDs, memory 
cards, and multimedia cards. These files are copied to the hard drive location you specify and added to the Organize 
workspace and Project view. 


Ensure that the footage you add to a project matches the project preset. In a mismatch, a dialog box appears 
informing you of the mismatch. Using the dialog box you can choose to let Adobe Premiere Elements change 
project settings to match your clips. 


Note: Image files cannot be imported. For photographs, use the Digital Still Camera And Phones option. 


 


 


 
Figure 7 Video Importer 


Capture / Pause button 


Source menu Device or disk contents 


Clip 
preview 


Presets 
menu 
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To use the Video Importer: 


1. Connect the media by doing one of the following: 


• Place a DVD in your computer’s DVD drive. 


• Connect the digital camera, mobile phone, or other 
device to your computer by connecting a cable to 
the USB 2.0 port.  


• Consult the owner’s manual for your computer for 
details on these and other options. 


2. In the Project workspace, click Add Media (Figure 8).  


 A list of devices appears. 


3. Click the device from which you want to import: 


• DVD Camcorder Or PC DVD Drive 


• Flip, AVCHD, Cameras, Phones, Or Removable 
Drive 


 Note: If you have an SD card reader or other card reader 
attached to your computer, choose Files And Folders to 
browse for the card reader. 


The Video Importer dialog box appears (Figure 9). 


4. In the Source Menu, select the device from which you 
want to download movie clips. 


The contents of the device or disk are displayed in the 
panel below the Source menu. The number of files and 
the size of the content is displayed at the bottom of the 
panel containing the content. 


5. Do one of the following: 


• To import all the content displayed in the panel, 
click Check All. 


• To import a few clips, click UnCheck All, and 
select only those clips that you want to import. 


Thumbnails of all importable files appear in the dialog 
box. 


Note: To preview the contents of a clip, click the clip, 
and then click the Play button in the Preview panel 
(Figure 9). 


 


 
Figure 8 List of import devices 


 


 
 


 


Figure 9 Video Importer dialog box 


 


 


 


 


Preview panel Check All and 
UnCheck All buttons 
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6. To specify a location for the saved files, do one of the 
following: 


• To save files to the default Adobe folder in the My 
Videos folder, leave the location as it appears in the 
dialog box. 


• To specify a different location, click Browse and 
choose a folder or click Make New Folder to create 
and name a new folder. 


7. Select a naming convention for the downloaded files 
using the Presets menu. 


File Name Retains the filenames assigned by the 
camcorder. 


Folder Name - Number If your folder name is Class 
Assignment, the clips are assigned the names Class 
Assignment - 001, Class Assignment - 002, and so on. 


Date - File name Adds a timestamp to the filename 
assigned by the camcorder. The timestamp is the current 
date and time - the date and time on which the movies 
were transferred to your computer. 


Note: To rename files, delete them from the Organizer, 
and then re-import them. 


Custom Name - Number Enter a custom name in the 
Name text box. For example, if you enter My Holiday in 
the text box, the clips are named My Holiday-001, My 
Holiday-002, and so on. 


8. (Optional) Other settings to consider include the 
following: 


• If you want to delete the selected files in the camera 
after import, select the option After Copying Delete 
Originals. 


• If you do not want the imported clips added to the 
timeline after import, deselect Add To Timeline. 
The imported clips are added only to the Organizer. 


• If you want to create an InstantMovie using the 
selected clips, select Create InstantMovie. 


9. Click Add Media. You can click Cancel in the Progress 
dialog box at any time to stop the process. 


 Note: If you don’t intend to use all the files you add, 
you can delete them from the Project view. Deleting 
files from the Tasks panel doesn’t delete them from your 
hard drive. This practice is recommended for large VOB 
files. 
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How to share video 
You can share movies, stills, and audio in a variety of file types to the web, mobile devices, videotape, Video CDs, 
and Super Video CDs. You can also copy and save projects for editing and storage. 


The Publish+Share panel (Figure 1) contains everything you need to save and share your finished project. You can 
save your project for viewing on the web, a personal computer, DVD, Blu-ray Disc, a mobile device, and more. 


You can start a new share by clicking any of the share options: web DVD, Disc, Online, Computer, Mobile Phones 
And Players. Each of these options opens a view in Publish+Share that provides specific options and settings for 
sharing to the respective media types. 
  


 
Figure 1 Publish+Share panel 


  


web DVD: Build web DVD for viewing online or on a computer. 


Disc: Burn DVD, Blu-ray, and AVCHD discs. To use this option, you must have a compatible disc burner 
installed. 


Online: Upload content to Facebook, Vimeo, or YouTube. For online services, content is automatically 
formatted to the site’s requirements.  


Computer: Create video to be viewed by others on their computers. You can select from a wide range of 
formats, including Adobe Flash Video, MPEG-2, Windows Media File, QuickTime video, or AVI. The format 
you choose depends on such factors as the platform (Windows Media Files, for example, cannot be played in 
Mac OS without a plug-in), quality level (AVI, AVCHD, MPEG-2 provide high quality video), and file size 
(Adobe Flash Video, QuickTime, and Windows Media Format all provide relatively small file sizes). 


Mobile Phones And Players: Export video for viewing on an iPod, Smart Phone, PSP, or other mobile device. 
Premiere Elements automatically chooses settings for selected devices, while allowing you to adjust other 
settings, such as audio and video quality. 


Note: The Publish+Share panel simplifies sharing and exporting by providing presets of the most commonly used 
formats and settings. If you want to specify unique settings for any format, you can click Advanced options and 
make changes.  
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Create DVD files for web 
web DVD files are DVD files played online. You can share your movie clips as web DVD files that can be 
embedded within web pages. The movie clips are exported in the Flash format. 


To create web DVD files for desktop: 


1. Click the Publish+Share panel (Figure 1). 


2. Click web DVD. 


Note: A web DVD requires that your project includes 
disk menu or chapters. If it does not, you are prompted 
to add them. Follow the steps to add them, and then 
repeat steps 1 and 2. 


web DVD view opens (Figure 2). 


3. Select Computer, Save To Folder On Computer. 


4. Select a preset from the Presets menu. 


5. In Project Name, enter a name for your project. 


6. In Save In, click Browse to select a location for the 
DVD output files. 


7. Click the Build button to create the web DVD. 


 The Build Completed message appears after the build is 
complete (Figure 3).  


8. Click Done or click the link to preview the generated 
web DVD file. 


  The file opens in your browser (Figure 4). 


 
 


Figure 2 web DVD view 


 


 
Figure 3 Build Completed message and link  


 


 
Figure 4 File open in a browser window 


Presets menu 
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Sharing to DVD and Blu-ray 
Sharing to a disc is ideal for large projects. You can share the movie to a DVD or Blu-ray disc. Depending on the 
complexity and length of the project and your computer speed, encoding (compressing) video and audio for a disc 
can take hours. If you plan to burn multiple discs with the same content and quality, you can save time by burning 
them in the same session, which compresses the project only once. 


To share to DVD or Blu-ray: 


1. Before starting Premiere Elements, connect and turn on 
all external DVD or Blu-ray burners. 


2. Click the Publish+Share panel and select Disc. 


Disc view appears (Figure 5). 


3. In Disc view, choose either DVD or Blu-ray from the 
menu. 


4. Select Disc as the Burn To option. 


5. Type a name for the disc.  


 This name appears in Windows if you insert the disc 
into a computer after the DVD burn has been completed. 
(The default name is a date stamp in 24-hour format: 
YYYYMMDD_hhmmss.) 


6. Select a burner from the Burner Location menu. 


7. Make sure that a compatible disc is inserted in the drive. 
If you insert a disc, click Rescan to check all connected 
burners for valid media. 


8. In the Copies box, enter the number of discs you want to 
burn during this session.  


 You are prompted to insert new discs until all have been 
burned. Encoding the video and audio takes place only 
once. 


9. For Presets, select the option for the television standard 
used in the geographic location of your audience. 


• NTSC Dolby DVD (Standard view; United 
States and other countries that use the NTSC 
standard) 


• NTSC Dolby Widescreen (16 x 9 view; United 
States and other countries that use the NTSC 
standard) 


• PAL Dolby DVD (Standard view; United 
Kingdom and other countries that use the PAL 
standard) 


• PAL Dolby Widescreen (16 x 9 view; United 
States and other countries that use the PAL 
standard) 


 
Figure 5 Disc view 
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10.  (Optional) Select Fit Contents To Available Space. If 
burning to a DVD, you can deselect this option and drag 
the slider to choose the video quality you want. (By 
default, this option is selected for DVD, and deselected 
for Blu-ray.) 


11. Click Burn to begin converting your project to the DVD 
or Blu-ray format and burning the disc. If you are 
burning a DVD, and a burner is not available, you can 
burn to a DVD folder, and then burn the resulting files 
to DVD when the burner is available. 


The Burn Completed message appears after the build is 
complete. 


Note: Encoding the video and audio for disc output can 
take several hours. 


12. Click Done. 


  


Sharing HD video 
AVCHD (Advanced Video Coding High Definition) is a file-based format for the digital recording and playback of 
high-definition video. Use AVCHD if you want to export your video to a high definition format that can be burnt on 
a DVD. The generated files can be played using an AVCHD compatible Blu Ray player. You can also export the 
generated files to a folder on your computer. You can copy the exported folder to a pen drive and play files by 
plugging the drive into the USB port of a Blu Ray player. You can also play the files on your computer using 
software that supports AVCHD. 


Note: Premiere Elements AVCHD files do not play on AVCHD camcorders. 


To share HD video on DVD: 


1. Before starting Premiere Elements, connect and turn on 
all external DVD or Blu-ray burners. 


2. Click the Publish+Share panel and select Disc. 


Disc view appears (Figure 6). 


3. In Disc view, choose HVCHD from the menu. 


4. Select Disc as the Burn To option. 


5. Type a name for the disc.  


 This name appears in Windows if you insert the disc 
into a computer after the DVD burn has been completed. 
(The default name is a date stamp in 24-hour format: 
YYYYMMDD_hhmmss.)  


 
Figure 6 Disc view 
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6. Select a burner from the Burner Location menu.  


7. Make sure that a compatible disk is inserted into the 
drive. If you insert a disk, click Rescan to check all 
connected burners for valid media. 


8. In the Copies box, enter the number of disks you want to 
burn during this session.  


 You are prompted to insert new discs until all have been 
burned. Encoding the video and audio takes place only 
once. 


9. For Presets, select the option for the television standard 
used in the geographic location of your audience. 


• NTSC Dolby DVD (Standard view; United 
States and other countries that use the NTSC 
standard) 


• NTSC Dolby Widescreen (16 x 9 view; United 
States and other countries that use the NTSC 
standard) 


• PAL Dolby DVD (Standard view; United 
Kingdom and other countries that use the PAL 
standard) 


• PAL Dolby Widescreen (16 x 9 view; United 
States and other countries that use the PAL 
standard) 


10. (Optional) Select Fit Contents to Available Space. If 
burning to a DVD, you can deselect this option and drag 
the slider to choose a video quality. 


11. Click Burn to convert the project and burn the disk.  


The Build Completed message appears after the build is 
complete. 


12. Click Done.  


  


Sharing online 
Adobe Premiere Elements enables you to export your movie in formats suitable for delivery through the Internet. 
Using the Publish+Share panel, you can upload your video directly to the web. Adobe Premiere Elements provides 
preset formats such as Adobe Flash Video (.flv), Flash Renamed MP4 file (.f4v), and QuickTime (.mov), which are 
commonly used to embed video into web pages and web applications. 


The Flash Video For Web preset covers the requirements of most servers and the bandwidth and player options 
available to most viewers. Using a preset is the quickest way to export your movie. You can also customize the 
settings to match a specific situation. Remember, however, to make sure that the data rate of your movie is 
appropriate for the intended playback medium.  


Adobe Premiere Elements makes it simple to quickly upload your movies directly to YouTube. You can set up an 
account and specify quality settings the first time you upload to YouTube. 
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To share a movie on YouTube: 


1. Click the Publish+Share panel and select Online. 


 Online view appears (Figure 7). 


2. Choose YouTube from the list.  


3. Use the Presets menu to set a format for your YouTube 
file (Figure 8). 


4. Click Next and log in to YouTube (Figure 9). If it is 
your first time uploading to YouTube, click Sign Up 
Now and register. Then log in. 


5. Click Next. 


 


 


 


 
Figure 7 Options in Online view 
 


 
Figure 8 YouTube Presets menu 


 


 
Figure 9 Log in to YouTube 
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6. Enter the required information about your project: Title, 
Description, Tags, and Category (Figure 10). Then click 
Next. 


7. Choose whether you want to allow the public to view 
your project, and then click Share. 


The Share Complete message appears after the share is 
finished uploading (Figure 11). You can choose View 
My Shared Video to open YouTube and watch your 
video (Figure 12) or Send An E-mail to send an e-mail 
about your new posting. 


8. To return to the main Publish+Share panel, click Done. 


 
Figure 10 Movie information 
  


 
Figure 11 Share Complete message  


 
Figure 12 Viewing the video on YouTube 
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Sharing to your computer 
The video you edit in the Timeline or Sceneline is not available as an independent video file until you export it, or 
share it, to a video format. After export, you can play it back on your computer, view it in other media players or 
editing programs, and move it to other computers. 


Sharing a movie for computer playback generally creates files with data rates and file sizes that exceed the limits for 
successful playback on the Internet, VCD, SVCD, DVD, or handheld devices.  


 


To share to your computer: 


1. Click the Publish+Share panel and select Computer. 


 Computer view appears (Figure 13). 


2. Choose a format from the list.  


 For example, if you are distributing and viewing the 
project on the web, you might choose Adobe Flash 
Video. 


3. Choose a quality level from the Presets menu.  


 As with other quality settings, file size increases as 
quality increases. 


4. Enter a name for the file.  


 This is the name that will appear on your computer. 


5. Click the Browse button to select a location for the file 
on your computer. 


6. Click Save. 


 Premiere Elements renders the file and saves the file to 
your computer in the location you selected. As with 
other formats, rendering may take some time. 


 Once the rendering completes, you will see a 
confirmation message. To view the file, browse to its 
location. 


7. Click Done. 


 
Figure 13 Computer view 


Sharing to a mobile phone or player 
With Premiere Elements, you can share projects to a range of handheld media players and mobile phones so viewers 
can watch your movies on these players. 


With this option, you first format the project and save it to your computer. Later, you can move the file to a media 
player or mobile phone. 


Each player or phone has particular requirements. For more information on the specifications for your desired player 
or phone, go to the manufacturer’s website. 







 Adobe Premiere Elements 11 guide 


© 2012 Adobe Systems Incorporated How to share video 9 


To share to a mobile phone or player: 


1. Consult the user guide for the device to determine the 
video file formats it supports. 


2. In the Publish+Share panel, click Mobile Phones And 
Players. 


 Mobile view appears (Figure 14). 


3. Choose your phone or player from the list.  


 For example, to share video on the Apple iPod, choose 
Apple iPod And iPhone. 


4. Choose a quality level from the Presets popup menu.  


 As with other quality settings, file size increases as 
quality increases 


5. Enter a name for the file.  


 This is the name that will appear in both your computer 
and the phone/player. 


6. Click the Browse button to select a location for the file 
on your computer.  


 This is the location from which you will copy the file to 
a phone or player. 


7. Click the Advanced button to open the Export Settings 
dialog box (Figure 15). 


 You can use the Audio tab in the Export Settings dialog 
box to adjust the settings for the audio file. 


8. If you are exporting video, make sure the Export Video 
option is selected. If you are exporting audio only, make 
sure the Export Video option is not selected. 


9. Click OK to close the Export Settings dialog box. 


10. Click Save to export your audio or video file. 


 Premiere Elements renders the file and saves the file to 
your computer in the location you selected. As with 
other formats, rendering may take some time. 


 Once the rendering completes, you will see a 
confirmation message. To view the file, browse to its 
location. 


 Note: Depending on the file type, you may not be able 
to view the movie on your computer unless you have the 
correct player installed. 


11. Click Done. 


 
Figure 14 Mobile view 


 


 
Figure 15 Export Settings dialog box with Video 
tab selected 
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How to work with audio 


At least half of your movie’s impact comes from its use of sound. Adobe Premiere Elements provides the tools, such 
as the Audio Mixer and the Audio Meters, to create a high-quality sound mix. You can narrate clips or set beat 
markers while previewing in real time. You can add a soundtrack to your movie, and trim it to the proper length, or 
use SmartSound® soundtracks, which you customize to exactly fit your project. You can set the overall volume 
levels of clips and the relative volume levels within and among them. Finally, you can remove unwanted noises and 
add effects to the sounds in your movie. 


Premiere Elements supports the following soundtrack file formats:  


• Dolby AC-3 (.ac3) 


• Macintosh Audio AIFF (.aif, .aiff) 


• mp3 Audio (.mp3) 


• MPEG Audio (.mpeg, .mpg, .mpa, .mpe, 
.m2a) 


• QuickTime (.mov, .m4a) 


• Windows Media (.wma) 


• Windows WAVE (.wav) 


Adding an audio soundtrack 
To complement the sounds embedded in video clips and any narration you record, add audio clips to the Soundtrack 
track visible in Quick view timeline or the Expert view timeline (Figure 1). At times, you must scroll down the 
audio portion of the Expert view timeline to see the Soundtrack. These clips typically contain background music or 
recordings of environmental sound. 
  


 
Figure 1 Audio file in the Expert view timeline 


  


To import audio and add a soundtrack: 


1. If necessary, add the desired audio files to your project. 


2. Click Music on the Action bar to display the Music 
panel (Figure 1). 


3. Drag an audio clip from the Music panel into the 
Soundtrack track of the Quick view timeline or the 
Expert view timeline where you want the audio clip to 
begin. 


       Note: You can also drag audio clips to the Expert view 
timeline through the Project Assets panel. 
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4. To adjust the position of the soundtrack, drag it to the 
right or left. 


 Note: There are separate tracks for narration and other 
music or sound effects. If you move a narration clip, this 
may cause the narration to become out of sync with the 
video. 


5. In the Quick view timeline or the Expert view timeline, 
select an audio clip in the Soundtrack track. (You might 
need to scroll down through the audio tracks to see the 
Soundtrack track.) 


6. Click the Play button in the Monitor panel (Figure 2). 


Premiere Elements previews the Soundtrack audio clip 
along with any audio and video clips above it in the 
Quick view timeline or the Expert view timeline. 


7. To stop the preview, click the Pause button in the 
Monitor panel. 


 


 
Figure 2 Monitor panel controls and Expert view 
timeline  


Using SmartSound tracks 
Included with Adobe Premiere Elements is the SmartSound Express Track plug-in. Use SmartSound Express Track 
to select from among a large collection of sound tracks for your video project. Then use SmartSound tools to 
customize the length of the sound track so that it corresponds exactly with the length of your movie. 


To use SmartSound Express Track on your video project, select SmartSound from the Music panel in the Expert 
view timeline, and follow the prompts. The SmartSound Express Tracks dialog box (Figure 3) opens alongside the 
SonicFire Pro 5 window.  
  


 
 


Figure 3 SmartSound Express Track dialog box 


Play / Pause button 


Play button Send button Variation and Mood menus 


Length 
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To use SmartSound tracks: 


1. From the Music panel in the Expert view timeline, click 
Use SmartSound (Figure 4). 


       Note: if this is your first time using SmartSound, you 
may have to perform a one-time installation. Follow the 
onscreen instrucitons to download and install the 
SmartSound plug-in.  


2. The Sonicfire Pro plug-in dialog box appears 
(Figure 5). It might take a minute for the dialog to 
appear on first launch as it updates sound files. Do not 
click the Cancel button. 


       The SmartSound Express Track dialog also appears 
(Figure 3), the files with a blue icon are the files you 
can use for free. You can view them by unchecking 
SmartSound Store on the top left of the application. You 
can use the search and filter options at the top of the 
dialog box to search for music. 


       If you are using SmartSound any time after the first 
installation, an update dialog appears asking you to 
install any latest updates. Click Update Now to update 
the plug-in, or click Update Later if you want to 
postpone installing the update. These updates are not 
necessary for using SmartSound with Premiere 
Elements. 


3. Select a file that you want to use in Adobe Premiere 
Elements. You can click the Play button to preview a 
sound. 


4. Enter a length for the soundtrack.  


 This should match the length of the clip to which you 
want to apply the soundtrack.  


5. Select a variation and mood for the soundtrack.  


 Variations determine tempo, intensity, and other 
characteristics of the sound. Mood adjusts the volume 
and intensity of the instruments, such as drums, 
percussion, strings, and horns to set a desired mood.   


6. Click the Play button to preview the changes.  


7. Click Send to export the file to the Project Assets panel. 
Ensure that you do not click the drop down menu 


       Switch to Adobe Premiere Elements and notice that the 
file has been added to the Project Assets panel. 


8. Use the file as you would any other sound files in Adobe 
Premiere Elements. 


9. (Optional) To import additional files from SmartSound, 
click Use SmartSound from the Music panel, and re-run 
this procedure. 


 
 


Figure 4 Music panel  


 


 
Figure 5 SonicFire Pro window 


 
  


SmartSound button 
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Creating narrations  
Using your computer’s microphone, you can narrate clips while previewing them in the Monitor panel. Your 
narration is then added to the Narration soundtrack visible in either the Quick view timeline or the Expert view 
timeline.  


For best results, confirm that your microphone is working correctly with your computer and Adobe Premiere 
Elements before narrating a clip. 


To narrate a clip: 


1. Plug a microphone into your computer’s microphone 
port. 


2. Choose Edit > Preferences > Audio Hardware 
(Windows) or Adobe Premiere Elements 9 > 
Preferences > Audio Hardware (Mac OS). 


3. From the Default Device menu, select your computer’s 
sound device, and click OK (Figure 6).  


 Note: If your mic is not listed, click ASIO Settings, 
click Input, select your device, and click OK. 


4. Do one of the following: 


• In the Expert view timeline, drag the current-time 
indicator to the point where you want the narration 
to begin. 


• In the Quick view timeline, select the clip you want 
to narrate. Then, drag the current-time indicator to 
the point where you want the narration to begin. 


5. In the Quick view timeline or Expert view timeline, 
select Narration from the Tools panel  (Figure 7). 


6. In the Record Voice Narration window, click the Mic 
Source button  and select your sound device from the 
menu (Figure 8). 


7. For best results, turn off your computer speakers to 
prevent feedback. To monitor sound while you narrate, 
plug headphones into your computer and deselect Mute 
Audio While Recording. 


Note: If your speakers are turned on, move as close to 
the microphone as possible, and keep the microphone as 
far away from the speakers as possible to prevent 
feedback. 


 


 


 


 


 
Figure 6 Audio Hardware Preferences  
  


 
Figure 7 Tools panel  


 


 


 
 


Figure 8 Record Voice Narration dialog box 


Mike SourceStart/Stop Recording Narration 


Delete  Present Narration 
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8. Speak into the microphone at a conversational volume, 
and raise or lower the Input Volume Level slider until 
your loudest words light up the orange part of the 
meters. 


9. Click the Record button. 


 Near the top of the Record Voice Narration window, a 
timer appears next to Start Recording In.  


10. When Start Recording In changes to Recording, speak 
your narration as the selected clip plays. 


11. When you finish narrating, click the Stop button. 


An audio clip containing your narration is added to the 
Project Assets panel and to the Narration track in the 
Quick view timeline or the Expert view timeline (below 
the selected clip) (Figure 9). 


12. To preview your recording, click the Go To Previous 
Narration button. Then click the Play Present Narration 
button. 


13. To continue recording from the position of the current-
time indicator, click the Start Recording Narration 
button again. 


This new recording overwrites any narrations that are 
traced over by the current-time indicator in the Narration 
track. 


14. Click the Pause Present Narration button at any time to 
stop the preview. 


15. To discard a narration, click the Delete Present 
Narration button (Figure 8) 


 The old narration clip is removed from the Timeline or 
Sceneline, but remains in the Project view of the Tasks 
panel. 


 
Figure 9 Narration audio clip in the Narration 
track in the Expert view timeline 


 


 


 


Layering sounds using multiple tracks 
When creating the soundtrack for your video project, you will often want to include multiple tracks—for example, a 
vocal narration, background music, and sound effects.  


In Premiere Elements, you can add multiple audio tracks and then use the built-in audio mixer to create layered 
soundtracks. Start by adding new empty audio tracks and then drag audio clips to the Timeline. By overlapping 
audio clips at the same position in the timeline (but on separate tracks), you create a layered multi track soundtrack 
(Figure 10). Adding multiple tracks is only available in the Expert view timeline. 
  


 
Figure 10 Multiple track soundtrack in Expert view timeline 
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You can also create and export a multi-track sound file using a separate sound editing application. You can then 
import the layered file for use in your Premiere Elements project.  


To add audio tracks to the Expert view timeline: 


1. Choose Timeline > Add Tracks. 


 The Add Tracks dialog box appears (Figure 11). 


2. Enter the number of tracks to add in the Audio Tracks 
Add box. 


3. Open the Audio Tracks Placement menu, and choose 
either Before Last Track or After Last Track. 


4. Click OK. 


 The new empty audio tracks appear in the Timeline.  


5. Drag audio clips from the Project Media bin to the 
empty tracks in the Timeline. 


 
Figure 11 Add Tracks dialog box 


 


Mixing and balancing audio elements 
Mixing audio involves adjusting volume levels so that they maintain a good range within each clip, and then 
adjusting them in proportion to other clips used in the movie. For example, you might first adjust the volume of a 
narration clip so that there is little variance between its softest and loudest sections; then raise the narration’s overall 
volume so that it is clearly audible over background sounds or music included in other clips.  


In Adobe Premiere Elements, volume changes are measured in decibels. A level of 0.0 dB is the original volume 
(not silence). Changing the level to a negative number reduces the volume, and changing the level to a positive 
number increases the volume. 


To control a clip’s volume, you can use the Volume graph—the yellow line running horizontally across the audio 
track of each clip (sometimes referred to as the volume rubberband)—or the Audio Mixer. You can use the Audio 
Meters window to view the overall audio volume for your project. 


Consider the following guidelines when adjusting volume levels: 


• If you combine particularly loud audio clips on multiple tracks, clipping (a staccato distortion) may occur. 
To avoid clipping, reduce volume levels. 


• If you need to adjust the volume separately in different parts of a clip (for example, one person’s voice is 
faint, while later another’s is too loud), you can use keyframes to vary the volume throughout the clip. 


• If the original level of a clip is much too high or low, you can change the input level. However, adjusting 
the input level will not remove any distortion that may have resulted from recording the clip too high. In 
those cases, it is best to re-record the clip. 
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Use the Audio Mixer to adjust audio balance and volume for different tracks in your project (Figure 12). You can 
adjust the balance and level of audio contained within your video clips, and within soundtrack and narration audio. 
For example, you may want to increase the volume of the narration and decrease the volume of the soundtrack at 
different points for emphasis or so that quiet voices can be heard above the music. 


You can adjust settings while listening to audio tracks and viewing video tracks. Each track in the Audio Mixer 
corresponds to an audio track in the Timeline or Sceneline, and is named accordingly. As you make adjustments, 
keyframes are added to the track. You can specify a default minimum interval for keyframes in the Audio 
preferences. 
  


 
Figure 12 Audio Mixer 


  


To use the Audio Mixer: 


1. (Optional) Choose Edit > Preferences > Audio / Adobe 
Premiere Elements 11 > Preferences > Audio, and set a 
value between 1 and 2000 milliseconds for Minimum 
Time Interval Thinning (Figure 13) to limit keyframes 
to intervals larger than that value. If you don’t want to 
hear audio while you scrub audio, deselect Play Audio 
While Scrubbing. 


 


 
Figure 13 Audio Preferences  
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2. In the Expert view timeline, click the Tools panel and 
select Audio Mixer option (Figure 14) or choose Tools 
> Audio Mixer. 


3. Drag the current-time indicator to where you want to 
start mixing audio. 


4. Click Play in the Monitor window and adjust the 
controls in the Audio mixer (Figure 15) to automatically 
add keyframes to the track: 


• To adjust balance for a track, turn (drag) the 
Balance control left or right. 


• To increase the volume for a track, drag the Level 
control up or down. 


Note: You can specify the spacing of keyframes in the 
Audio preferences. 


To mute a track while mixing, click Mute. This option 
does not mute the track permanently—only while 
mixing. 


5. Close the Audio Mixer when you are finished mixing 
the audio. 


 


 
Figure 14 Tools panel  


 


 
 


Figure 15 Adjust balance and levels in the Audio 
Mixer 


 
  


Mute track checkbox 
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Using the SmartMixer  
Sometimes the background music is loud and the dialogs in a clip are not audible. To ensure that the dialogs are 
easily heard, the volume of the background music must be lowered. SmartMix enables automatic adjustment of the 
volume of the background music (Figure 16). For best results, place dialog clips on the Audio 1 track or the 
Narration track (Foreground tracks) and music on the Soundtrack track (Background tracks). Premiere Elements 
analyzes clips on all Foreground tracks for dialogs. Keyframes are then smartly/automatically created to lower the 
volume level to ensure that the dialog in the Foreground track is audible. SmartMix adjustments apply to all audio 
clips on the Expert view timeline, not just on the selected clip. When you use SmartMix on an audio track, 
keyframes you applied previously on the Soundtrack are deleted.  


 


 
Figure 16 SmartMixer panel 


To use the SmartMixer: 


1. Finish adding all audio elements to your project, 
including: 


• Audio from original video 


• Narration 


• Soundtracks (including SmartSound soundtracks) 


2. In the Expert view timeline, click the Tools panel and 
select Smart Mix (Figure 17), or choose Tools > 
SmartMix . 


 The SmartMixer panel of the Mixer Options dialog box 
opens (Figure 16). Here, you set each audio track as 
foreground, background, or disabled (Figure 18). 


3. Set options for each track. For example, if you want the 
narration always to be louder than the other tracks, set 
Narration as Foreground and Audio 1 and Soundtrack to 
Background (where Audio 1 is the sound attached to the 
video). 


 


 
Figure 17 Tools panel  


 


 
Figure 18 Setting Narration as Foreground  
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4. Click Apply. 


 Premiere Elements automatically adjusts the volume of 
each track so that the narration is always in the 
foreground.  


5. Close the Mixer Options dialog box. 


 Premiere Elements automatically lowers the volume of 
Audio 1 and Soundtrack while Narration is occurring. 
The sound levels are raised when the narration ends 
(Figure 19). 


6. To fine-tune audio track levels, expand the Audio Mixer 
in the Mixer Options panel. You can manually adjust 
Balance and  Levels for each of the audio tracks in your 
project  


 
Figure 19 SmartMix applied 


Repairing and enhancing audio  
Sometimes your video clip contains an audio track that is poorly recorded, or includes unwanted noise. You can 
repair problems and enhance audio using audio effects (Figure 20). You can also apply multiple audio effects to a 
clip. 
 


 
Figure 20 Properties for the New Blue Noise Reducer audio effect 
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To repair and enhance an audio track: 


1. Click Effects on the Action bar to open the Effects 
panel. 


2. Select the effect you want to apply. To locate an effect, 
choose Audio Effects from the category  menu at the top 
of the panel (Figure 21), or type the effect name in the 
search box.  


The Audio Effects appear in the Effects panel. To repair 
an audio track, you might choose the NewBlue Noise 
Reducer from the selection in the Effects view. 


3. Select a clip or multiple clips in the Expert view 
timeline. 


       Note: To select non-consecutive clips, Ctrl-click/Cmd-
click each clip. To select consecutive clips, click in the 
Project Assets panel, and drag a marquee around the 
selected clips. 


4. Drag the audio effect to the clip’s soundtrack in the 
Expert view timeline. 


5. To preview the audio effect, double-click the clip in the 
Project Assets panel and the click the Play button in the 
Preview window. 


       Note: Audio playback controls are available only if the 
selected clip contains audio. 


6. To adjust the settings, expand the effect in the Applied 
Effects panel, and edit the settings based on your 
requirement (Figure 22). 


Note: Each audio effect includes a bypass option that 
lets you turn the effect on or off as specified by the 
keyframes that you set. 


7. To remove an effect, click the Trash button in Applied 
Effects panel.  


8. (Optional) You can apply other effects to enhance your 
audio file, such as Bass to boost the low decibel 
response of the soundtrack. 


 


 
Figure 21 Effects panel 


 


 


 
Figure 22 Applied Effects panel 


 


Exporting an audio soundtrack 
After creating and mixing the audio for a project, you can export the final soundtrack as a single file. To export the 
audio from a project, use the Share tab. The Export command on the File menu is used for exporting titles only. 


Category menu 


Bypass option Trash button 
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To export audio from a project: 


1. Before exporting the soundtrack, choose Timeline > 
Render Work Area. 


 A progress bar charts the render process (Figure 23). 


2. Click Publish+Share panel and click the Computer 
option (Figure 24).  


3. Scroll the list of options and click Audio (Figure 25). 


4. Select a file type from the Presets menu. 


       Note: To specify advanced settings, such as frequency 
and bit rate, click Advanced, select the Audio tab, and 
adjust the settings. 


5. Specify a location and filename, and click Save. 


 The file is created in the format and location that you 
specified. A message tells you when the export is 
complete. 


6. Click Done.  


   


 
Figure 23 Rendering dialog box 


 


 
Figure 24 Publish+Share panel 


 


 
 


Figure 25 Publish+Share panel, Computer option 


 


Presets menu Advanced button 
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Podcasting 
In Adobe Premiere Elements, you can create audio or video files to use in podcasts by exporting files. 


Exporting audio and video for podcasting 
If you want to create an audio file for use in a podcast, you should save it as an MP3 or AAC file. To export the 
audio from your movie in the format of your choice, use the Mobile Phones And Players option in the 
Publish+Share panel. 


You select an export format by choosing the mobile device you want to target and then choosing a preset format for 
the exported file (Figure 1). Adobe Premiere Elements offers a number of preset formats optimized for specific 
devices. Use the provided presets for best results. If your project requires special settings, you can click the 
Advanced button and make changes.  
  


 
Figure 1 Publish+Share panel 


  


 All mobile files are compressed by using the H.264 compression standard. To help you decide which preset to 
choose, each preset’s specific settings for file type, frame size, frame rate, audio frequency, file size, and duration 
are listed below the preset name. You can choose from the following formats when sharing to a mobile phone or 
player: 


Apple iPod And iPhone: Creates a file that plays back optimally from an iPod or iPhone. Choose iPod And 
iPhone High Quality or iPod And iPhone Medium Quality.  


Audio Podcast: Creates an audio file in MPEG-4 Movie format for optimal playback from an iPod or other 
audio player or mobile phone. Choose Audio Podcast – High Quality, Audio Podcast – Medium Quality, or 
MP3 Audio Podcast.  


Pocket PC: Creates a Windows Media Video (.wmv) file for optimal playback on a Pocket PC.  


Smartphone: Creates a Windows Media Video (.wmv) file for optimal playback on a Smartphone. Choose a 
landscape or portrait preset.  


Sony PSP (PlayStation Portable): Creates an MPEG-4 Movie file for optimal playback on a Sony PSP device. 
Choose the High Quality, Medium Quality, or Widescreen preset.  


Mobile Phone: Creates an MPEG-4 Movie file for optimal playback on a mobile phone. Choose a preset based 
on the desired final frame size and whether you want a 3GP file or an MP4 file. 


Advanced button 


Preset menu 
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To export audio or video for podcasting: 


1. Consult the user guide for the device to determine the 
video file formats it supports. 


2. In the Publish+Share panel, click Mobile Phones And 
Players (Figure 2). 


 Mobile view appears (Figure 1). 


3. Choose your phone or player from the list.  


 For example, to share video on the Apple iPod, choose 
Apple iPod And iPhone. 


4. Choose a quality level from the Presets popup menu.  


 As with other quality settings, file size increases as 
quality increases 


5. Enter a name for the file.  


 This is the name that will appear in both your computer 
and the phone/player. 


6. Click the Browse button to select a location for the file 
on your computer.  


 This is the location from which you will copy the file to 
a phone or player. 


7. Click the Advanced button to open the Export Settings 
dialog box (Figure 3). 


 You can use the Audio tab in the Export Settings dialog 
box to adjust the settings for the audio file. 


8. If you are exporting video, make sure the Export Video 
option is selected. If you are exporting audio only, make 
sure the Export Video option is not selected. 


9. Click OK to close the Export Settings dialog box. 


 If you modified the settings, you are prompted to save 
the settings as a new preset.  


10. Name the new settings and click OK. 


11. Click Save to export your audio or video file. 


 Premiere Elements renders the file and saves the file to 
your computer in the location you selected. As with 
other formats, rendering may take some time. 


 Once the rendering completes, you will see a 
confirmation message. To view the file, browse to its 
location. 


 Note: Depending on the file type, you may not be able 
to view the movie on your computer unless you have the 
correct player installed. 


 
Figure 2 Publish+Share panel 


 


 
Figure 3 Export Settings dialog box with Audio 
tab selected 


 







